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BAB I  

PENDAHULUAN 

 

 

1.1 Latar Belakang 

Kerja Praktek Merupakan salah satu program yang di peruntukkan bagi 

mahasiswa guna untuk mengetahui dan memperoleh pengalaman di dunia 

kerja.Kerja Praktek ini juga merupakan salah satusyarat yang harus dipenuhi oleh 

mahasiswa, khususnya mahasiswa Politeknik Negeri Bengkalis.Kerja praktek ini 

bertujuan untuk melatih mahasiswa agar memiliki pengalaman untuk menghadapi 

dunia kerja secara nyata dan juga sebagai wadah bagi mahasiswa untuk berinteraksi 

langsung dengan dunia industri. 

Mengingat dengan semakin majunya teknologi saat ini, banyak instansi atau 

perusahaan yang memanfaatkan teknologi dalam mengembangkan usahanya. Salah 

satu perusahaan atau instansi yang memanfaatkan teknologi dalam membangun 

usahanya adalah Radio Republik Indonesia di RRI Bengkalis. Radio Republik 

Indonesia adalah jaringan radio publik berskala nasional di Indonesia. RRI 

didirikan pada tanggal 11 September 1945 dan diperingati sebagai Hari Radio 

Indonesia . Berfokus pada Informasi- Informasi yang akan di siaran kepada 

masyarat, Seiring dengan perkembangan tekonlogi RRI juga menyiaran informasi 

berupa video dan text melalui media social seperti facebook, whatsaap dan website 

resmi. 

Berdasarkan UU No. 20 tahun 2003 tentang Sistem Pendidikan Nasional 

menjelaskan bahwa Kerja Praktek (KP) merupakan salah satu muatan kurikulum 

suatu lembaga pendidikan. Dalam hal ini lembaga pendidikan yang dimaksud 

adalah lembaga pendidikan kejuruan.KP tersebut bertujuan untuk memberikan 

wawasan praktis berdasarkan teori-teori yang dipelajari di lembaga pendidikan 

kejuruan. 

Bagi penulis sendiri latar belakang dilakukannya praktik kerja ini diantaranya 

yaitu penulis dapat menerapkan ilmu pengetahuan dalam dunia kerja secara 

langsung serta mendapatkan pengalaman dan juga sebagai salah satu syarat untuk 
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dapat menyelesaikan pendidikan pada program studi D4-Keamanan Sitem 

Infromasi. 

1.2 Tujuan 

Kegiatan KP bertujuan sebagai berikut : 

1. Memberi kesempatan kepada mahasiswa untuk mengaplikasikan 

teori/konsep ilmu pengetahuan sesuai program studinya yang telah 

dipelajari di bangku kuliah pada suatu organisasi/perusahaan. 

2. Memberi kesempatan kepada mahasiswa untuk memperoleh pengalaman 

praktis sesuai dengan pengetahuan dan keterampilan program studinya. 

3. Memberi kesempatan kepada mahasiswa untuk menganalisis, mengkaji 

teori/konsep dengan kenyataan kegiatan penerapan ilmu pengetahuan 

dan keterampilan di suatu organisasi /perusahaan. 

4. Menguji kemampuan mahasiswa Politeknik Bengkalis (sesuai program 

studi terkait) dalam pengetahuan, keterampilan dan kemampuan dalam 

penerapan pengetahuan dan attitude/perilaku mahasiswa dalam bekerja. 

5. Mendapat umpan balik dari dunia usaha mengenai kemampuan 

mahasiswa dan kebutuhan dunia usaha guna pengembangan kurikulum 2 

dan proses pembelajaran bagi Politeknik Bengkalis (sesuai dengan 

program studi terkait). 

2.1 Manfaat 

Sedangkan manfaat kegiatan KP bagi mahasiswa dan Politeknik Bengkalis 

yaitu: 

1. Mahasiswa mendapat kesempatan untuk menerapkan ilmu pengetahuan 

teori/konsep dalam dunia pekerjaan secara nyata. 

2. Mahasiswa memperoleh pengalaman praktis dalam menerapkan ilmu 

pengetahuan teori/konsep sesuai dengan program studinya.Mahasiswa 

memperoleh kesempatan untuk dapat menganalisis masalah yang 

berkaitan dengan ilmu pengetahuan yang diterapkan dalam pekerjaan 

sesuai dengan program studinya. 

3. Politeknik Bengkalis memperoleh umpan balik dari 
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organisasi/perusahaan terhadap kemampuan mahasiswa yang mengikuti 

KP di dunia pekerjaannya. 

4. Politeknik Bengkalis memperoleh umpan balik dari dunia pekerjaan 

guna pengembangan kurikulum dan proses pembelajaran. 

 

2.2 Luaran Proyek Kerja Praktek 

Selama melakukan proyek yang diberikan pada saat kerja praktek adapun 

output yang akan diimplementasikan pada Radio Republik Indonesia di Bengkalis 

yaitu penggunaan adobe audition untuk kebutuhan menjernihkan suara hasil dari 

wawancara. 



 

BAB II 

GAMBARAN UMUM RADIO REPUBLIK INDONESIA DI BENGKALIS 

 

 

2.1 Profil dan Sejarah Singkat Radio Republik Indonesia Bengkalis 

Radio Republik Indonesia di Bengkalis adalah satu-satunya radio yang 

menyandang nama negara, siarannya ditujukan untuk kepentingan seluruh lapisan 

masyarakat diseluruh wilayah negara kesatuan Republik Indonesia. Cikal bakal 

lahirnya RRI di mulai dari organisasi penyiaran radio Jepang pada saat masih 

dalam masa penjajahan Jepang yang digunakan sebagai alat propaganda untuk 

kepentingan militer Jepang dengan sebutan Hoso Kyoku yang berpusat di Jakarta. 

Kelahiran RRI tidak terlepas dari situasi yang terjadi pada saat itu, yaitu kekalahan 

Jepang terhadap sekutu. Sementara itu disisi lain ketika Indonesia menyatakan 

kemerdekaannya, para pemimpin radio siaran yang tersebar diseluruh pulau Jawa 

mengadakan pertemuan dan mengusulkan agar semua radio siaran yang ada di 

pulau Jawa diserahkan kepada Pemerintahan Indonesia yang sudah merdeka. 

Radio Republik Indonesia (Bengkalis). Berdiri pada tanggal 11 September 1945 

pukul 17.00 WIB, delegasi radio sudah berkumpul di bekas Gedung Raad van 

Indie Pejambon dan diterima wakil dari pemerintah RI. Abdulrahman Saleh yang 

menjadi ketua delegasi menguraikan garis besar rencana dalam pertemuan 

tersebut. Salah satunya adalah meminta kepada pemerintah RI untuk 

menggunakan radio sebagai alat komunikasi dengan rakyat, sebab Sekutu akan 

mendarat di Jakarta akhir September 1945. Radio dipilih sebagai alat komunikasi 

karena lebih cepat dan tidak mudah terputus andaikata terjadi 

pertempuran.Delegasi kemudian menyarankan agar pemerintah RI meminta 

kepada otoritas Jepang yang masih ada di Jakarta untuk menggunakan peralatan 

Radio Hoso Kyoku.Namun, sejumlah petinggi negara, termasuk beberapa 

menteri, keberatan karena alat-alat milik Jepang tersebut sudah terdaftar sebagai 

barang inventaris Sekutu.Para delegasi radio tetap bersikukuh dan akhirnya 

diambil jalan tengah. 



 

Beberapa keputusan yang direkomendasikan kepada pemerintah RI dalam 

pertemuan itu antara lain, pertama, dibentuknya Persatuan Radio Republik 

Indonesia di Bengkalis yang akan meneruskan penyiaran dari 8 stasiun di Jawa. 

Yang kedua yakni mempersembahkan RRI kepada Presiden Sukarno sebagai alat 

komunikasi dengan rakyat.Terakhir atau ketiga, menyarankan supaya semua 

hubungan antara pemerintah dan RRI disalurkan melalui Abdulrachman 

Saleh.Pemerintah RI menyanggupi rekomendasi tersebut dan siap membantu RRI 

meskipun mereka masih tidak sependapat dalam beberapa hal.Setelah itu, tepat 

pukul 24.00 WIB, delegasi 8 stasiun radio mengadakan rapat di rumah Adang 

Kadarusman.Dalam pertemuan itu dihasilkan kesepakatan, yakni didirikannya 

RRI dengan Abdulrachman Saleh sebagai pemimpinnya. 

Radio Republik Indoneisa di BengkalisDidirikannya RRI Bengkalis untuk 

memberikan layanan informasi, khususnya sebagai wilayah perbatasan dalam 

upaya penetrasi kesenjanhan informasi. Dimana selama ini masyarakat Kabupaten 

Bengkalis hanya dapat menikmati siaran dari radio negeri jiran Malaysia. 

„‟Keberadaan RRI di Bengkalis, di samping untuk menjawab aspirasi dari 

masyarakat juga menindaklanjuti pertemuan lintas kementrian yang intinya, RRI 

harus ada di Bengkalis. 

Tujuan Penyiaran diselenggarakan dengan tujuan untuk memperkukuh 

integrasi nasional, terbinanya watak dan jati diri bangsa, memajukan 

kesejahteraan umum, dalam rangka membangun masyarakat yang mandiri, 

demokratis, adil dan sejahtera serta menumbuhkan industri penyiaran Indonesia. 

 

Gambar 2.1 Logo RRI  



 

2.2 Visi dan Misi Radio Republik Indonnesia di Bengkalis 

2.2.1 Visi Lembaga Peraturan Penyiar (LLP) 

Terwujudnya RRI Sebagai Lembaga Penyiaran Publik Yang Terpercaya 

Dan Mendunia. 

2.2.2 Misi Lembaga Peraturan Penyiar (LLP) 

1. Menjamin terpenuhinya hak warga Negara terhadap kebutuhan 

Informasi yang objektif dan independen sehingga memberikan 

kepastian dan rasa aman kepada warga Negara, serta menjadi referensi 

bagi pengambilan keputusan. 

2. Menjamin terpenuhinya hak warga Negara terhadap pendidikan melalui 

siaran yang mencerdaskan dan hiburan yang sehat serta berpihak 

kepada kelompok rentan (pengungsi, orang terlantar, pekerja migran, 

pribumi, anak, perempuan, minoritas dan suku terasing) serta disable. 

3. Memperkuat kebhinekaan melalui siaran budaya yang mencerminkan 

identitas bangsa. 

4. Menjamin siaran yang mudah diakses sehingga kehadiran Negara 

dalam pelayanan Informasi dirasakan oleh seluruh warga Negara. 

5. Menghadirkan siaran di daerah perbatasan, terpencil, terluar dan pesisir 

sebagai representasi Negara dalam konteks menjadikan daerah 

pinggiran sebagai pusat aktivitas kultural 

6. Menyelenggarakan siaran luar negeri untuk mempromosikan budaya 

beserta Ideologi Indonesia dan menghadirkan kebudayaan dunia ke 

Indonesia. 

7. Menjamin penyelenggarakan LPP RRI dengan tatakelola yang sesuai 

dengan prinsip good public governanMelibatkan partisipasi publik 

dalam pengelolaan LPP RRI. 

8. Mengembangkan SDM yang mendukung kebutuhan Lembaga 

Penyiaran Publik yang terpercaya dan termuka 

9. Mengembangkan strategi komunikasi dan promosi serta memperluas 

jejaring kemitraan dengan berbagai lembaga atau Instansi dalam dan 



 

luar negeri demi memperkuat keberadaan LPP RRI. 

10. Mengoptimalkan potensi yang dimiliki RRI sebagai sumber pendapatan 

yang dijamin oleh aturan perundangan untuk memperkuat keberadaan 

LPP RRI. 

2.3 Struktur Oraganisasi Sekretariat Daerah Kabupaten Bengkalis 

Berikut merupakan struktur organisasi bagian Organisasi Sekretariat Daerah 

Kabupaten 

 

Gambar 2. 1 Struktur Organisasi RRI 

2.4  Ruang Lingkup Instansi 

Radio Republik Indonesia Merupakan jaringan Radio Publik berskala 

Nasional di Indonesia, RRI bergerak dibidang Informasi berita Pada Bidang 

jadwal siaran juga membuat jadwal pola siaran atau kegiatan lainya. Adapun 

Kegiatan yang sudah dilaksanakan ialah: 

1. Penyiar 

Penyiar adalah kegiatan penyeleggaraan siaran radio maupun televise, 

yang diselenggarakan oleh organisasi penyiaran radio atau televisi. 

Adapun aspek dalam penyeleggaran penyiaran yaitu : 

a) Komunikasi Massa 

b) Organisasi 



 

c) Kelembagan 

d) Teknologi 

e) Operasional 

f) Regulasi 

2. Siaran 

Siaran Merupakan kegiatan penyiar dilakukan oleh organisasi penyiaran, 

organisasi penyiar ini bersifat publik sektor. Siaran Merupakan hasil  

perpanduan antara kreativitas manusia dan kemampuan alat/siaran atau 

perangkat keras dan perangkat lunak sebagai berikut: 

Adapun perangkat keras adalah; 

a)  Sarana dan prasarana seperti gedung, jalan, studio, kamera, 

elektronik dan statip dan lain-lain. 

b)  Pemancar dan perangkatnya Adapun Perangkat Lunak adalah : 

a) Manuisa Pengelola 

b) Program



 

BAB III 

BIDANG PEKERJAAN SELAMA KERJA PRAKTEK 

 

 

3.1 Spesifikasi Tugas Dilaksanakan 

Kerja Praktek (KP) dilaksanakan terhitung mulai dari tanggal 26 Maret 

2024 sampai dengan tanggal 26 Juli 2024 di Radio Repubilik Indonesia Kabupaten 

Bengkalis. Selama pelaksanaan KP ada beberapa pekerjaan dan tugas yang 

dikerjakan, yaitu diantaranya: 

3.1.1 Melakukan Edit hasil rekaman pada rri bengkalis 

 

Gambar 3.  1 Melakukan edit hasil rekaman 



 

3.1.2 Memasukkan hasil rekaman 

 

Gambar 3.  2 Memasukkan hasil rekaman 

3.1.3 Target Yang Diharapkan 

Dalam pelaksanaan Kerja Praktek (KP) yang berlokasi di RRI Kabupaten 

Bengkalis dan terhitung selama 16 minggu terdapat beberapa target yang ingin 

dicapai, diantaranya: 

a) Memahami dunia kerja di penyiaran. 

b) Dapat memanfaatkan pengetahuan dan kemampuan di bidang IT 

sebagai bekal untuk memulai usaha dan mencari pekerjaan. 

c) Mengembangkan pengetahuan dan kemampuan di bidang IT untuk 

diterapkan di penyiaran. 

3.1.4 Perangkat Yang Digunakan 

Pelaksanaan Kerja Praktek (KP) di Sekretariat Daerah Kabupaten 

Bengkalis menggunakan beberapa perangkat, baik perangkat lunak (software) 

maupun perangkat keras (hardware). 

3.1.5 Perangkat Lunak (Software) 

Adapun perangkat lunak yang akan digunakan adalah sebagai berikut: 



 

3.1.6 Adobe Audio Editor 

 

Gambar 3.  3 Adobe Audio Editor 

Adobe Audition adalah perangkat lunak yang digunakan untuk mengedit dan 

mencampur audio untuk berbagai kebutuhan, seperti film, televisi, musik, dan 

podcast. Beberapa fitur yang dimiliki Adobe Audition, di antaranya: Merekam 

suara, Memperbaiki kualitas suara, Menambahkan efek suara, Menggabungkan 

beberapa track suara menjadi satu track, Menyimpan file audio dalam berbagai 

format. 

3.1.7 Perangkat Keras (Hardware) 

Adapun perangkat keras yang akan digunakan adalah sebagai berikut: 

 

Gambar 3. 1 Laptop 

(Sumber: https://www.bhinneka.com/jual-laptop-notebook/y81WyE6) 

Laptop adalah komputer pribadi yang berukuran relatif kecil dan ringan. 

Biasanya memiliki berat antara 1-6 kg, tergantung pada ukuran, bahan, dan 



 

spesifikasi dari laptop tersebut. laptop ini akan digunakan sebagai perangkat untuk 

perancanganaplikasi, perancangan dan pembuatan database, pembuatan aplikasi, 

penginputan data, serta pembuatan laporan. 

3.1.8 Data-Data Yang Diperlukan 

Yang paling utama ialah audio yang di dapatkan dari rekaman. Referensi 

tampilan website yang akan mahasiswa kerja praktek buat. 

3.1.9 Kendala Yang Dihadapi Selama Kerja Praktek 

Selama melaksanakan Kerja Praktek (KP) di RRI Kabupaten Bengkalis 

terdapat beberapa kendala yang dihadapi dalam mengerjakan tugas yang diberikan 

oleh pembimbing di instansi. . 

3.1.10 Pemecahan Masalah 

Pemecahan terhadap masalah yang dihadapi ialah dengan mencari referensi 

sebanyak mungkin melalui internet, serta menanyakan saran dari pembimbing di 

instansi dan pembimbing kerja praktek. Berdasarkan referensi dari beberapa 

sumber maka proses melakukan edit pada audio hasil rekaman. 



 

BAB IV 

DESAIN UX PADA WEBSITE JADWAL PENYIARAN RADIO 

 

4. 1 Metodologi 

4.1.1 Urain Judul 

Menjernihkan Suara dengan Adobe Audition pada RRI Bengkalis. 

4.1.2 Prosedur Pembuatan Sistem 

Adapun prosedur melakukan edit untuk menjernihkan suara adalah sebagai 

berikut: 

1) Membuka Software Pengedit Suara 

Buka aplikasi pengedit suara seperti Audacity, Adobe Audition, atau 

software lainnya. 

2) Mengimpor File Audio 

Impor file audio yang ingin dijernihkan ke dalam software. 

3) Menghapus Noise Awal 

Identifikasi bagian audio yang hanya mengandung noise (tanpa suara 

utama). Terapkan fitur Noise Reduction untuk menghapus noise tersebut. 

4) Mengaplikasikan Equalizer 

Gunakan Equalizer untuk menyesuaikan frekuensi tinggi, menengah, dan 

rendah. Atur frekuensi untuk menjernihkan suara dan mengurangi noise 

tambahan. 

5) Menggunakan Filter De-Esser 

Terapkan De-Esser untuk mengurangi bunyi “S” yang terlalu tajam. 

6) Menghapus Distorsi 

Gunakan fitur Clip Fix atau Repair Distortion untuk menghilangkan distorsi 

dari audio. 

7) Menambahkan Kompresor 

Terapkan Compressor untuk menyeimbangkan level suara, memastikan 

tidak ada bagian yang terlalu keras atau terlalu lemah. 



 

8) Menambah atau Mengurangi Gain 

Sesuaikan gain untuk mengatur volume keseluruhan dari file audio. 

9) Mendengarkan dan Mengecek Kualitas 

Dengarkan hasil edit untuk memastikan suara jernih dan tidak ada noise 

yang tertinggal. 

10) Ekspor File Audio 

Jika sudah puas dengan hasilnya, ekspor audio ke format yang diinginkan 

seperti MP3 atau WAV. 

4.1.3 Metodologi Pengumpulan Data 

Dalam pembuatan sistem, teknik yang digunakan dalam pengumpulan data 

Menggunakan Metode wawancara dan Observasi langsung dengan penyiar untuk 

mengetahui permasalahan apa yang sedang di alami dan bagaimana 

menyelesaikan masalah tersebut. 

1) Wawancara 

Wawancara merupakan salah satu teknik pengumpulan data yang 

dilakukan melalui tatap muka secara langsung dengan narasumber 

dengan Tanya cara jawab langsung. Wawancara dilakukan dengan para 

pengguna bagaimana dengan tampilan yang diinginkan. 

2) Observasi 

Suatu metode pengumpulan data yang dilakukan dengan mengamati 

langsung, melihat dan mengambil suatu data yang dibutuhkan ditempat 

penelitian dilakukan. 

4.1.4 Proses Perancangan 

1) Analisis sistem yang sedang berjalan 

Pada sistem pengolahan audio yang sedang berjalan saat ini, pengguna 

RRI Bengkalis masih menggunakan metode manual untuk 

menjernihkan suara siaran, yang memerlukan waktu lama dan hasil 

yang tidak selalu optimal.  

2) Rancangan sitem yang diusulkan 

Pada sistem yang diusulkan, pengguna dapat menggunakan Adobe 



 

Audition untuk mengotomatisasi dan mempercepat proses pembersihan 

audio. Pengguna dapat langsung mengimpor file audio siaran ke dalam 

aplikasi, melakukan penghilangan noise, penyesuaian equalizer, serta 

menambahkan kompresor untuk menjernihkan suara. Dengan tampilan 

yang intuitif, pengguna dapat dengan mudah memahami cara 

penggunaan Adobe Audition untuk proses ini. 

4.1.4.1 Adobe Audition 

 

Gambar 4.  1 Adobe Audition 

 (Sumber :  Data Olahan) 

4.1.4.2 Tahapan Edit Audio Adobe Audition 

Adobe Audition adalah salah satu perangkat lunak audio editing profesional 

yang sangat populer di kalangan musisi, podcaster, dan penggemar audio. Salah 

satu fitur utama Adobe Audition adalah kemampuannya untuk menjernihkan suara 

rekaman yang mungkin terdengar kurang jelas atau penuh dengan gangguan. 

Berikut adalah langkah-langkah untuk menjernihkan suara menggunakan Adobe 

Audition. 

1) Langkah 1: Impor File Audio 

Pertama, buka Adobe Audition dan impor file audio yang ingin Anda 

perbaiki. 



 

1. Buka Adobe Audition. 

2. Klik "File" > "Open" dan pilih file audio yang ingin Anda edit. 

2) Langkah 2: Identifikasi Masalah Suara 

Sebelum melakukan editing, dengarkan keseluruhan rekaman untuk 

mengidentifikasi bagian-bagian yang membutuhkan perbaikan, seperti 

noise, hum, atau distorsi. 

3) Langkah 3: Penggunaan DeNoise Effect 

Noise adalah masalah umum dalam rekaman audio. Adobe Audition 

memiliki fitur DeNoise yang dapat membantu mengurangi noise. 

1.  Pilih bagian audio yang berisik atau seluruh file jika perlu. 

2. Klik "Effects" > "Noise Reduction/Restoration" > "Noise Reduction 

(Process)". 

3. Klik "Capture Noise Print" untuk mengambil sampel noise dari bagian 

yang berisik. 

4. Setelah itu, terapkan Noise Reduction pada seluruh file atau bagian yang 

dipilih dengan mengatur slider sesuai kebutuhan. 

4) Langkah 4: Penggunaan DeReverb Effect 

Reverb atau gema yang berlebihan dapat membuat suara terdengar kurang 

jelas. Adobe Audition menyediakan DeReverb untuk mengatasi masalah 

ini. 

1. Pilih bagian audio yang terdampak reverb. 

2. Klik "Effects" > "Noise Reduction/Restoration" > "DeReverb". 

3. Atur parameter yang tersedia sampai suara terdengar lebih jelas dan 

bersih. 

5) Langkah 5: Equalization (EQ) 

Penggunaan EQ dapat membantu memperbaiki frekuensi tertentu yang 

membuat suara terdengar kurang optimal. 

1. Pilih audio yang ingin diperbaiki. 

2. Klik "Effects" > "Filter and EQ" > "Graphic Equalizer" (10, 20, atau 30 

Bands). 

3. Sesuaikan slider frekuensi untuk meningkatkan atau mengurangi 



 

frekuensi tertentu. Biasanya, pengurangan frekuensi rendah bisa 

mengurangi hum, sementara peningkatan frekuensi menengah bisa 

membuat suara lebih jelas. 

6) Langkah 6: Kompresi 

Kompresi dapat membantu mengurangi perbedaan volume antara bagian 

terendah dan tertinggi dalam rekaman. 

1. Pilih audio yang ingin diperbaiki. 

2. Klik "Effects" > "Amplitude and Compression" > "Multiband 

Compressor". 

3. Sesuaikan pengaturan kompresor untuk mencapai suara yang lebih 

seimbang dan jelas. 

7) Langkah 7: Normalisasi 

Normalisasi audio berguna untuk memastikan level volume keseluruhan 

konsisten. 

1. Pilih seluruh file audio. 

2. Klik "Effects" > "Amplitude and Compression" > "Normalize 

(process)". 

3. Atur level normalisasi (misalnya -3dB) dan terapkan. 

8) Langkah 8: Final Touches 

Lakukan pengecekan terakhir dengan mendengarkan kembali audio yang 

telah diedit. Jika diperlukan, lakukan penyesuaian kecil pada efek yang telah 

diterapkan. 

9) Langkah 9: Ekspor File 

Setelah selesai, simpan perubahan dan ekspor file audio yang sudah 

diperbaiki. 

1. Klik "File" > "Export" > "File". 

2. Pilih format yang diinginkan (misalnya WAV atau MP3) dan klik "Save". 



 

BAB V 

PENUTUP 

 

 

5.1 Kesimpulan 

1) Proses pengeditan audio untuk penyiaran Radio Republik Indonesia (RRI) 

Bengkalis dilakukan menggunakan aplikasi Adobe Audition, yang 

menyediakan fitur untuk menjernihkan suara dan meningkatkan kualitas 

siaran. Aplikasi Adobe Audition digunakan untuk memudahkan penyiar 

dalam mengedit rekaman siaran, termasuk menghilangkan noise, 

menyeimbangkan suara, serta menambahkan efek audio yang dibutuhkan. 

Selain itu, aplikasi ini juga memungkinkan penyiar untuk mengatur dan 

menyesuaikan berbagai aspek suara dengan mudah, memastikan bahwa hasil 

akhir siaran berkualitas tinggi dan siap disiarkan kepada pendengar RRI 

Bengkalis 

2) Pelaksanaan Kerja Praktek dapat menambah ilmu tentang jenis-jenis 

pekerjaan yang ada di RRI Kabupaten Bengkalis.. 

5.2 Saran 

1) Bagi Perusahaan 

 Sesuai dengan pengamatan penulis Kerja Praktek dari kegiatan praktek 

kerja lapangan selama 6 Bulan di Radio Republik Indonesia di Bengkalis, 

terdapat beberapa saran dan mungkin dapat member kebaikan bagi semua 

pihak, yaitu Radio Republik Indonesia diBengkalis diharapkan terus 

konsisten dalam menjalan kan visi dan misinya. 

2) Bagi mahasiswa 

Sangat direkomendasikan bagi mahasiswa khususnya untuk program Studi 

Keamanan Sistem Informasi yang memiliki keahlian pada bidangnya. 
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